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Objects 

Bar 

Description 

 

 Bars are representative of something solid, such as steel, 
aluminum, brass, wood, etc. 
A bar can be set to appear… 

• Angled 
• Curved 
• Straight 
• Twisted 
• Pointed 

Bars are used to construct rail sections, pickets, rail cap, pipes, tubes, etc. 

Creating New 

1. Click the Bar button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the bar will stretch out. 
5. Release the mouse button. 

Creating a Curved Bar 
1. Select only the bar that you would like to curve (when selected, it turns blue). 

2. Move the mouse pointer over the green circle in the middle of the bar.  



3. Left-click the green circle – do not release the mouse button 
4. Move the mouse pointer 
5. Release the mouse button 

Properties 
While a bar is selected, you may change the dimensions of the bar in the bar properties box on the right 
side of the screen. Use the right scroll bar to view more properties that may be hidden due to your screen 
size.  
Accent Color 
The Accent Color is the color of the twist lines contained within a twisted bar when your drawing is 
shaded in color. When the drawing is solid shaded (outlined), all lines including accent lines, are black. 
Remember: 

• After entering a number in a properties text box, press the “Enter” key on your keyboard so the 
changes will take effect. 

• When needed, hold the “Shift” key on your keyboard while moving an end point on the bar, to 
force it horizontal, vertical, or 45 degrees. 

• Hold the “Ctrl” key on your keyboard while moving an end point on the bar to snap the end to 
another bars’ end point or other object. If you successfully connect the ends of two bars together, 
you can select the two bars and the Miter function will be available on the right side of the screen. 

Twisted Bar 
You may twist bar clockwise or counter-clockwise. Twists are allowed in multiples of 0.25 (quarter turn). 
For example you can have 2 whole twists or numbers such as 2.25, 1.75, 0.5, 0.25, etc. 
If you see any distortion in the twists on a twisted bar, you may need to reduce the number of twists to fit 
in the twist distance. 

Mitering Two Bars 

      
If you have successfully connected the end points of two different bars, the Miter buttons will be available 
after the two bars are selected. Use the “Ctrl” key to connect end points. 
 

   
Three bars connected and not 

mitered 
Mitered with joint line Mitered without joint line 

Extend 
You can extend the length of a straight bar to butt up against with another object in the drawing. 

 

 

 



Selected bar before extend Click extend button Bar after extend 
The straight bar will extend, if there is an object in its direct path. The bar’s end angle will change to 
match the angle of the surface of the other object. The maximum modified extend angle is 80 degrees (0 
degrees is a straight cut).  

Band 

Description 
Bands are used to wrap around scrolls and pickets for a decorative appeal. Bands should be drawn last or 
moved to the front layer of the drawing order. To change the order, select the band or all bands 
(Edit>Select>Bands) and go to (Edit>Arrange>Bring to the Front) 

Creating New 

1. Click the Band button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the band will stretch out. 
5. Release the mouse button. 

Properties 

 

Click the blue Style box to access the band library and to change the 
band style. 

Accent Color 
The Accent Color is the color of the lines contained within a component when your drawing is shaded in 
color. When the drawing is solid shaded (outlined), all lines including accent lines, are black. 

Bricks 

Description 
This object is a quick way to create an instant brick or block wall that is limited to a rectangular shape. 
You cannot remove bricks individually from the wall. If you want to show a window or opening in a wall, 
the best method is to draw the brick wall, then draw a rectangle object with its fill property set to white. 

Creating New 

1. Click the Bricks button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer diagonally and the brick wall will stretch out. 
5. Release the mouse button. 

Properties 
Brick Library 
You may choose from a few brick styles in the Bricks Library dropdown list box. This will load the brick 
height, width, mortar thickness and colors into the properties. 



Dimensions 
The dimensions of the brick or mortar are a guideline only. The actual height and with of the bricks and 
mortar will automatically shrink or expand to accommodate full and half bricks to evenly fill the space in 
the brick wall rectangle.  

Circle 

Creating New 

1. Click the Circle button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the circle will stretch out. 
5. Release the mouse button. 

Properties 
Ellipse 
A circle can be changed to an ellipse. After you change it to an ellipse, click and drag one of the four 
green circles on the outer perimeter of the circle to resize. 
Line Thickness 
The thickness represents the line thickness in pixels on the screen or printer. 
Line Style 
The circle perimeter can be dashed or dotted if the line thickness is 1. 
Fill 
The circle fill property can be set to no fill, drawing default fill color, or a custom color. Pattern fill is not 
available at this time. 

Linear Dimension 

Description 
The linear dimension is used to display hideable dimensions on your drawing. 

Creating New 

1. Click the Linear Dimension button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the circle will stretch out. 
5. Release the mouse button. 
6. If you would like the text to display in another location, click on the green circle in the middle of 

the text and move it. 



Features 

 

Dimensions can show straight distances, horizontal distances, and vertical 
distances. 

1. Use the “Ctrl” key on your keyboard to snap the end points (green 
squares) of the dimension to an object. 

2. Click on the green square over the dimension text and move it to a 
location of your choice. 

3. To make horizontal or vertical dimensions, simply hold the “Shift” 
key on your keyboard while moving the green square over the 
dimension text. 

 

Properties 
Text 
You can click on the green circle point to move the text and arrows. 
The text height is in inches or cm and is to scale with the drawing. You may change the text displayed at 
any time.  
Color 
Initially, the color is set to the drawing default dimension color, which can be changed in the 
(Drawing>Color Defaults>Dimensions) menu. 

Angle Dimension 

Description 
The angle dimension helps you to display an angle on your drawing. It can be visible or hidden when you 

click the show/hide dimension buttons.  

 

Creating New 

1. Click the Angle Dimension button  on the left side of the screen. Use the left scroll bar to view 
buttons that may be hidden below. 

2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the angle dimension will stretch out. At this point, it is closed. 
5. Release the mouse button. 
6. Click down on the square (not the circle) in the middle of the line that appeared. Keep the mouse 

button down. 
7. Move the mouse pointer and the angle dimension will appear. 
8. Release the mouse button. 

Properties 
Text 
You can click on the green circle point to move the text and arrows. 



The text height is in inches or cm and is to scale with the drawing. You may change the text displayed at 
any time.  
Color 
Initially, the color is set to the drawing default dimension color, which can be changed in the 
(Drawing>Color Defaults>Dimensions) menu. 

Frame 

Description 
A frame object was designed to rapidly give you a metal frame with the dimensions that you desire. It can 
be rectangle with straight sides, or with as many as two arched sides. If the curved side is not on the side 
that you desire, simply rotate the frame by selecting it and click the adjustment buttons. 

Styles 

 

• Rectangle 
• Curved one end 
• Curved on both ends 

Creating New 

1. Click the Frame button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer diagonally and the frame will appear. 
5. Release the mouse button. 

 

Properties 
Thickness 
You may change the thickness of any of the bars that make up the frame. 
Corner Joints 
You can show the joints between bars as butt, miter or none. When you have a curved side, you are 
restricted to mitered joints or none. 

Line 

Description 
Lines can be straight or curved. Lines are also an essential part of component drawing. Polylines, 
polygons and rectangles can be exploded into lines. 

Creating New 

1. Click the Line button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the line will appear. 
5. Release the mouse button. 



Properties 
Line Thickness 
The thickness represents the line thickness in pixels on the screen or printer. 
Line Style 
The line can be dashed or dotted if the line thickness is 1. 
Special Functions 
Lines can be manipulated further by the following. 

• Convert to Polyline – The selected line is combined with any other lines that share endpoints in a 
string of connected lines. 

• Cut – cuts a line into 2 or more lines 
• Scale – The end points of a line can be scaled horizontally and vertically.  

Remember: 
• After entering a number in a properties text box, press the “Enter” key on your keyboard so the 

changes will take effect. 
• When needed, hold the “Shift” key on your keyboard while moving an end point of the line, to 

force it horizontal, vertical, or 45 degrees. 
• Hold the “Ctrl” key on your keyboard while moving an end point of the line to snap the end to the 

end point of another object. 

Point 

Description 
• Used as reference points on a drawing for snapping other object to them. 
• Points are not significant on a printout of a drawing and often are too small to appear. 
• Two points are required when in Component Drawing mode. 

Creating New 

1. Click the Line button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area where you would like to place the point. 
3. Click down with the left mouse button. 
4. Release the mouse button. 

Selecting 
Since points are tiny, it is best to drag a selection rectangle over them. 

PolyBar 

Description 
A Polybar is one continuous formed bar containing straight, twisted, curved scrolled and lambs tongue 
segments. 
Common Uses 

• Rail cap with lambs tongue 
• Scrolls 
• Brackets 
• Handles 
• Pipe clamps 



Polybars are sometimes difficult to manipulate with the mouse pointer. For some applications, you might 
consider using several bars with common endpoints mitered together instead of using a polybar. For 
instance, polybars are not appropriate for use as the top bar of a curved top gate.    

Creating New 

1. Click any Polybar button     on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the polybar will appear. 
5. Release the mouse button. 

More Polybar Styles 

Click the Formed Bar button  on the left side of the screen. 

 

After clicking the Formed Bar button, many more polybar style will buttons appear.  
 
After you select a style, you draw it in the same way as shown above. 
 
After the polybar is drawn on the screen, you can then change its properties such as 
thickness, segment length, radius, scroll radius, scroll style, number of twists, etc, 
depending upon the types of segments in the polybar. 

Polybar Assistant 
You may create custom polybars using the section assistant. 

Click the Polybar Assistant button  

 

In this window, you can create your own 
polybar shapes. 
 
You must have one straight segment between 
any bends or scrolls. 
 

Use the rotate buttons   if you need to 
visualize your custom polybar differently. 
 
Click “Accept” when you are finished. 
 
When you are back at the drawing screen, 
click down and drag out the new polybar. 

 



Properties 
Segment Properties 

 

To access the properties of each individual segment, click on any item in the 
Segment List dropdown list box. 

Bar Length 
The Bar Length property at the top of the polybar properties window is the total calculated length of all of 
the segments that make up the polybar. Each individual segment has its own bar length as well. 
Scroll 

 

• To change the scroll style and access the scroll style library, 
click on the blue rectangle. 

• The radius is not the scroll width, instead it is the distance from 
the center of the scroll spiral to the furthest bent part of the bar. 

• The Sizes property mainly applies to scroll benders that have 
sizes marked on them such as the Shop Outfitters scroll bender 
that has the sizes A, B, C, D, E and so forth cast into the 
bender. 

• The Bar Length property is a close estimate by Ornamental Pro 
as to the length of material contained in the scroll segment 
itself.  

 

Polygon 

Description 
A polygon can have as few as three sides (triangle) and as many as ten sides (decagon). OP2010 makes 
drawing polygons to exact specifications very easy. You may find this feature very useful for non-
drawing purposes such as calculating the length of the sides are if you know the width. It also calculates 
the angle of sides and polygon height. 

Creating New 

1. Click the Polygon button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area to a place you would like to start the center of the 

polygon. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the polygon will appear. 
5. Release the mouse button. 



Properties 
Diameters 

  
Inner diameter of a polygon Outer diameter of a polygon 

Line Thickness 
The thickness represents the line thickness in pixels on the screen or printer. 
Line Style 
The polygon perimeter can be dashed or dotted if the line thickness is 1. 
Fill 
The polygon fill property can be set to no fill, drawing default fill color, or a custom color. Pattern fill is 
not available at this time. 

Polyline 

Description 
A polyline is a continuous line containing two or more nodes and line segments. Line segments within a 
polyline can be straight or curved. CNC artwork is often made up of many polylines. You would also use 
polylines to represent walls with door openings, pillars, non-standard steps or stairs, etc. 
OP2010 allows several polylines and circles to be contained within one polyline. 
Nodes 
The joint between two line segments on a polyline is called a node. 

Creating New 
Polyline Object 

1. Click the Polyline button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area to a place you would like to start the polyline. 
3. Click down with the left mouse button and release the mouse button 
4. Move the mouse pointer to another area that you would like to place the next node.  
5. Click and release the mouse button. 
6. Repeat the moving and clicking until your polyline has the desired number of nodes. 
7. Press the “Esc” or “Escape” key on your keyboard or right-click the mouse button to create the 

final node. 
Polyline from Lines 
You may also create a polyline from individual lines that have their end points connected together. This is 
often the best way to create the exact shape that you desire. 

1. Draw several individual lines on the drawing area using the line object button.  
2. Make sure that the lines are connected on the ends. Press the “F12” key on your keyboard to 

display any disjointed line endpoints.  
3. To connect the line end points, press and hold the “Ctrl” key on your keyboard while moving a 

selected lines end point over another unselected lines end point. Release the mouse button and 
then the “Ctrl” key. 

4. Select one or more of the lines in the chain of connected lines so it or they turn blue. 
5. Go to the menu (Objects>Line Functions>Convert to Polyline) and click. 
6. All of the connected lines should now be selected as a polyline. 



7. If your polyline is closed, you can see if it can be solid filled by clicking the shade button.   

Combining Polylines 
CNC artwork is a major example of combined polylines. The polylines all move together when adjusting 
and most importantly, they represent an outer perimeter and openings when shaded. 

1. Select the polylines to be combined. 
2. Go to the menu (Objects>Line Functions>Combine Polylines) and click. 

3. You can check the appearance of your combined polylines by clicking the shade button.  

Other Functions 
Explode 
You can explode a polyline into individual lines by clicking the menu (Objects>Line Functions>Explode) 
Scale 
The width and height of polylines can be modified with the scale function. Click the menu (Objects>Line 
Functions>Scale) and a window will open allowing you to either enter a new height or width or a 
percentage of the height or width. 
The “Maintain Proportions” checkbox will maintain the same ratio between height and width.  
Always press the “Enter” key after entering a number in a text box. 

Rectangle 

Description 
A rectangle can be rotated, cut, and exploded. 

Creating New 

1. Click the Rectangle button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer diagonally and the frame will appear. 
5. Release the mouse button. 

Creating a Square 
You can create a square by holding down the “Shift” key on your keyboard while moving any one of the 
four corner points. 

Properties 
Line Thickness 
The thickness represents the line thickness in pixels on the screen or printer. 
Line Style 
The rectangle perimeter can be dashed or dotted if the line thickness is 1. 
Fill 
The rectangle fill property can be set to no fill, drawing default fill color, or a custom color. Pattern fill is 
not available at this time. 

Ring 

Description 
A ring is a representation of a solid material such as metal, forming a circle. 



Creating New 

1. Click the Ring button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area to a place you would like to start the center of the 

ring. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the ring will appear. 
5. Release the mouse button. 

Properties 
Ellipse 
A ring can be changed to an ellipse. After you change it to an ellipse, click and drag one of the four green 
circles on the outer perimeter of the ring to resize. 

Spiral 

Description 
A spiral is basically a polyline with special rate of growth properties. 

Creating New 

1. Click the Spiral button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area to a place you would like to start the outer point 

of the spiral. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the spiral will appear. 
5. Release the mouse button. 

Properties 
Rate of Growth 

 

The slider controls and text boxes labeled 1, 2, and 3 are there to 
adjust the spirals rate of growth. These control the rate of 
multiplication growth and addition growth per each revolution in 
the spiral. 

Line Thickness 
The thickness represents the line thickness in pixels on the screen or printer. 



Spline 

Description 
A spline is a curvy line with control points that you can adjust with the mouse pointer. Note: The 
dimension arrows can be set to spline as well. 

Creating New 

1. Click the Spline button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer and the spline will appear as a straight line. 
5. Release the mouse button. 
6. Click on one of the two control points (green circles) and drag it out away from the spline. 
7. Click and drag the other control point. 

Properties 
Line Thickness 
The thickness represents the line thickness in pixels on the screen or printer. 

Steps 

Description 
The Steps object is a fast and simple way to create a set of steps for your railing drawings. If you need to 
draw a complex set of steps, you will not use the steps object. Instead, you will need to construct complex 
steps by drawing a series of lines and eventually converting them to a polyline (see “Creating a Polyline” 
in this manual). 

Creating New 

1. Click the Steps button  on the left side of the screen. 
2. Move the mouse pointer inside the drawing area. 
3. Click down with the left mouse button – do not release the mouse button 
4. Move the mouse pointer diagonally and the steps will appear. 
5. Release the mouse button. 
6. Enter values into the “Slope Length” and “Slope Angle” text boxes and press “Enter” 

Tips for Measuring Steps 
One of the best ways to accurately measure steps 

• Only be concerned with the steps that you will be anchoring the railing posts. All other steps 
between the posts can fluctuate in size and do not matter if your bottom bar is suspended above 
them anyway. 

• Measure from corner point of one post step to the other post step. This is your “Slope Length” 
• Get the angle of the steps by placing an angle indicator on a straight edge lying on the points of 

the steps. This is your “Slope Angle” 
• Enter the “Slope Length” and “Slope Angle” into OP2010. 



Properties 
Stair Styles 

 
Basic Rectangle Rounded Lip 

 

Stair Style – choose between basic, rectangular lip and rounded lip 
 
Base Style – choose between block, ramp and none 
 
Slope Length - the distance from the corner point of the top step or landing to the 
bottom step.  
 
Angle – the angle of the points of the stairs 
 
Slope Rise – the vertical distance of the slope length 
 
Slope Run – the horizontal distance of the slope length 
 
Stairs Height – the height from the ground to the top of the stairs 
 
Total Length – the horizontal length from one end of the landing to the bottom 
step 
 
Landing Length – the large standing area at the top of the steps 

 

Text 

Description 
Text can be set to be dimension text (hideable) or regular text. Text editing is performed inside the 
drawing area. Text can be resized, rotated and colored. 

Creating New 

1. Click the Text button  on the left side of the screen. 
2. Move the mouse pointer in the drawing area to the location that you would like to place the text. 
3. Click and release. 
4. Edit the text by moving the mouse pointer directly over the text and double-click. 
5. If you have successfully double-clicked the text, it will turn purple. 
6. Use the “Backspace” key on your keyboard to edit the text. 
7. Type new text. 
8. Press the “Enter” key on your keyboard to add multiple lines of text. 



9. Click out in the white drawing area to deselect the text when you are done. 

Rotating 
To rotate the text, select it and click and drag one of its points (green squares). To straighten the text, hold 
the “Shift” key on your keyboard while moving one of the points. 

Properties 

 

Alignment – applies only if you have multiple lines of text. 
 
Hideable Notes – if checked, the text will hide along with dimensions when the 

hide/show dimensions button  is pressed. 
 
Font – click the font name to change the font. While choosing a new font, the font 
size in the font window is ignored. 
 
Font Size – equals the height of the text characters in scale with the drawing. If 
you have a 1 inch thick bar next to 1 inch text, they will appear the same. If you 
zoom in, the text will appear larger. 
 
Company info box – these lines of text can be changed by going to the menu 
(Tools>Program Options) and then choose the “Company Info” tab. 
 
Date – click this gray box to have your text change to the current date. 

 

Components 

Overview 
Components are object drawings of items such as spear caps, cast metal scroll panels, brackets, hinges, 
outdoor fixtures and so on. All components have been drawn in OP2010 and have many unique properties 
that allow you to manipulate them easily on the screen. They also can easily be colored by changing the 
line color, fill color and accent line color. 
Several libraries  

Supplier Component Libraries 
Several component libraries representing the product lines of various suppliers of castings and forgings 
are available for download at http://www.ornamentalpro.com/updates/components.htm on the web. These 
libraries are not included in OP2010, but are available free of charge. Occasionally, new libraries will be 
added for download as well as updates for existing libraries. 

Library 

To access the components installed on your computer, click the Component Library button.  

http://www.ornamentalpro.com/updates/components.htm


Navigating 

• Double-click a folder to view its contents 

• Click the Up Level button  to go back to 
the root folders. 

• Click the Forward and Backward buttons  to 
navigate through the pages of components. 

 

 

• Double-click the component that you would like 
to add to your drawing. 

• If you would like to add certain components to 
your favorites for fast retrieval, right-click the 
component and choose “Add to Favorites” 

Inserting Components in Your Drawing 

 

• OP2010 stores the last 20 components that you have accessed in the library. 

Use the arrow buttons  to cycle through them. 

• Click the center blue box  that has a thumbnail image of the desired 
component. Then move the mouse pointer over the drawing area and click 
the left mouse button to place the component. 

Manipulating Components 
• When selected, each component has two points (green squares) that you can click on and move the 

component around in the drawing area. 
• Use the “Ctrl” key on your keyboard to snap the component to another object. For example, you 

would use the “Ctrl” key to snap a spear cap to the end of a bar. 
• Use the “Shift” key on your keyboard to force the component to be horizontal or vertical. 

Creating New Components 
You can create your own components in OP2010 while in component mode. 
Refer to the Component Drawing Manual for instructions on creating your own components. 

Properties 
The Accent Color is the color of the lines contained within a component when your drawing is shaded in 
color. When the drawing is solid shaded (outlined), all lines including accent lines, are black. 
 



Background Image 

Description 
You can import an image as a background in OP2010. Because OP2010 is a vector-based (lines) program 
and not a raster-based (pixels) program, you are only allowed to open one image per drawing. 

Common uses for a background image in OP2010 
• To show a picture of a house with the drawing superimposed in front of it. 
• Scenery behind the drawing 
• For manual tracing of components in component mode. For example, you might have a catalog 

picture of a component that you would like to add to your library. You would then import the 
picture and outline the component using line objects.  

Computer Speed 
Unfortunately, larger images consume system resources and can slow the program down considerably. 
Whenever possible, toggle the image “Visible” checkbox to unchecked (off) until you are viewing the 
final drawing or when printing. You could also reduce the file size, and make any other adjustments to the 
image before loading it into OP2010. 

Loading an Image 

1. Click the Image button  at the top right on the screen. 

2. Click the Open button  in the Image Properties window on the right side of the screen. 
3. Locate the image file and click “Open”. 

Manipulating the Image 
• While the Image Properties window is open, you can click down on the image and drag it around 

the drawing area. 
• While the Image Properties window is open, you can adjust the image by clicking on the move 

and rotate buttons on the left side of the screen. 

• Resize - If the Resize button  is selected, you can click on one of the four green squares on the 
image to resize it. 

• Crop - If the Crop button  is selected, you can click on one of the four green squares on the 
image to crop out unnecessary portions of the image. 

• Scale - After you click the Scale button , you will then need to click on one location of the 
image and move the mouse pointer to another location and click. You will see a red line over the 
image. A window prompt will ask you to enter the “New Distance Equals” and press “Enter” on 
your keyboard. When scaling to photos of houses, remember that the objects in the background 
will appear smaller than they really are because of perspective. If you scale a house with this 
method, trust the heights or widths of the objects in the foreground.    

• Skew – You can skew the image horizontally or vertically if the camera angle was not straight. 
• Brightness – Often when tracing components, you will increase the brightness of the image so it 

will contrast with the lines that you are drawing. 
 



Cloning 

Description 
Cloning is a function that allows you to duplicate existing objects in various patterns. The clone objects 
are red in color and are not real until you convert them. You cannot clone the background image. 

How to Clone Objects 

Cloning Styles 

 

Horizontal Clones – one set of new clones are an equal distance from the dashed red 
clone guide line. 

 

Vertical Clones – one set of new clones are an equal distance from the dashed red clone 
guide line. 

 

Horizontal and Vertical Clones – three sets of new clones are an equal distance from the 
dashed red clone guide line both horizontally and vertically. Used often when drawing a 
picket pattern. 

 

Circular Clones – you specify the quantity of total like sets of objects. The quantity will 
include the original objects. This button shows a quantity of five. The new clones are in a 
circular pattern around the center of the clone guide lines. 

 

Linear Clones – you specify the quantity of total like sets of objects. The quantity will 
include the original objects. The new clones will be an equal spacing from the original 
objects at any angle that you specify. 

 

Array of Clones – you specify the total quantity of rows and columns of clones. You 
may also stagger every other row of clones. 

Cloning Objects 
1. Before entering clone mode, you need to select the objects that you would like to duplicate. 

2. Enter clone mode by clicking the clone button  at the top of the screen.  
3. Choose one of the clone styles from the six listed in Clone Styles and click. 
4. You are now in clone mode. If you want to change the cloning style, click the lone style button in 

the clone properties and you will be able to choose another style. 
5. The other objects that you did not take into clone mode will appear gray in color. Until you exit 

clone mode, these objects are not available for editing. 

6. If you need to move the clone guide closer to your objects, click the clone guide button  and 
then move the guide in the drawing area. When you are done moving the clone guide, click the 
clone guide button again to lock it in place. 

7. Move, rotate, edit your objects as desired. You may draw new objects as well. 
8. Once you are satisfied with the cloned object placement, click the “Convert Clones” button. The 

clones will be converted to real objects for further editing, deleting, etc. 



Cutting 

Description 
• The Cut function was mainly designed for bars, lines and polylines. Other objects can be cut but 

some may give you mixed results such as cutting a spiral.  
• You may cut many objects at once. For example, you can draw an entire railing or gate and slice it 

in half.  
• Bars are sliced into bars, lines are sliced into lines, and most everything else slices into polylines. 

How to Cut 
1. You do not need to select any objects. 

2. Click the Saw button  at the top of the screen 
3. Move the mouse pointer beside an object you would like to cut. 
4. Click down and drag out over the object or objects. 
5. Release the mouse button. 
6. If your saw line is over an object that can be cut, the object will turn light blue. 
7. If your saw line is not in the correct place, simply click down, drag and release. 
8. Once you are ready to cut, click the “Cut” button on the right side of your screen. 
9. Click the Saw button at the top of the screen to exit cut mode. 

Paper 

Description 
You have the option of placing your drawing, scaled on paper on your screen. The paper is shown in 
white and the surrounding area is gray. You are allowed one paper per drawing file. 

• You can also set the paper size and orientation. The orientation setting will overrule the 
orientation setting in the printer settings window when you print. 

• The paper size must match your default printers default paper size.  

Manipulating the Paper 

1. Click the Page button  at the top of your screen. 
2. Your drawing should be auto-scaled on the paper. 
3. If you would like a different scale, enter the new numbers in the scale text boxes and press “Enter” 

on your keyboard so the new values are accepted. 

Printing 

How to Print 

1. Click the Print button  or go to the menu (File>Print) 
2. The Outline Thickness and Accent Thickness is to scale 

the lines that make up the objects in your drawing. A line 
set to 1 pixel thick is visible on the screen, but might not 
be on your printer. 

 



Printing Errors 
99% of the times printing errors reported on previous versions of Ornamental Pro have been due to the 
following – check these first – don’t assume. 

Common Causes 
• Printer is off 
• Printer cable disconnected or network problem 
• Printer out of paper 
• Paper jam 
• Printer ink or toner out 
• You are accidentally printing to another printer while waiting for the printout to come out the 

intended printer 
• You used another program to print and now the print queue is full or is dominated by the other 

program. Check the printer properties in Windows and/or restart your computer. 
• The default paper size for the printer is different than the setting in OP2010   

Ornamental Pro Causes 
• The drawing has enormous detail and your printer buffer is inadequate to handle the job 

Keyboard Shortcuts 
+ Zoom In 
- Zoom Out 

Ctrl Snap a selected objects point to another unselected objects point 
Shift Force horizontal, vertical and 45 degrees 
Space Insert a new line 
Ctrl-A Select all objects in the drawing 
Ctrl-C Copy select objects to the OP2010 clipboard. 
Ctrl-V Paste the OP2010 clipboard 
Ctrl-Z Undo 
Esc End new polyline – To get out of other operations. 

Up Arrow Move the drawing view up 
Down Arrow Move the drawing view down 
Left Arrow Move the drawing view to the left 
Right Arrow Move the drawing view to the right 

F9 Component mode – convert all lines to polylines and combine them  
F10 Component mode – scale 
F12 Component mode – Check for disconnected line segments 
A Makes the current node on a new polyline an arc node 
L Insert a new line 
K Link line segments 
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